INDEX

PAGE# | SUBJECT
--- | ---
3 | What Is The Silhouette Cameo? (For Beginners)
4 | What Can the Silhouette Cameo Do? (For Beginners)
5 | Changes between the Silhouette Studio V2 & V3
6 | Tool Bar Icons Have Changed
7 | Silhouette Studio V3 Tools / Side Bar Options
8 | Silhouette Studio V3 Tools / Top Left Bar Options
9 | Silhouette Studio V3 Tools / Top Right Bar Options
10 | Features of The Silhouette Studio Designer Edition Upgrade
11-13 | Differences between Vinlys & Tapes
14 | Tracing
15 | Welding
16 | Release Compound Path vs. Grouping
17 | Editing Points
18 | New V3 Cut Settings
19 | Creating a Layered Design
20 | Silhouette Knockout Technique
21 | Silhouette Weeding Lines
22 | Subtract & Subtract All
23-24 | Creating Rhinestone Designs
25 | Rhinestone Decorating Step By Step Guide
26 | Siser’s Hand Iron-On Steps for HTV
27 | How to Nest and Re-Use Scrap Vinyl Pieces
28 | Opening SVG Files into Silhouette Studio
29 | Tips to Apply Vinyl Straight
30 | Tips to Apply Vinyl To A Curved Surface
31-33 | Silhouette Sketch Pens
The Silhouette CAMEO® is the ultimate DIY machine. From customizing your apparel to personalizing your party – and everything in between – the CAMEO will help you create your own DIY masterpiece.

It’s the ultimate personal cutting machine. Like a home printer, it plugs into your PC OR Mac with a simple USB cable. However, instead of printing it uses a small blade to cut paper, cardstock, vinyl, fabric and more, up to 12” wide and 10 feet long. Utilizing your computer allows you the freedom to cut all your fonts, and design shapes of your own with the included software for this die cutting machine. No cartridges required! The machine also boasts a quiet motor and the ability to register and cut printed materials.

The new design of the 2015 Cameo includes features like electronic touch control panel, Crosscutting tool for slicing roll off of the machine, blue guide marks, side storage tray for spare blades, and side USB port for cutting directly from a USB device. It is also compatible with the new PIXscan cutting mat and the Roll Feeder, each sold separately.

Silhouette Comes with:

- Silhouette CAMEO electronic cutter tool
- Silhouette Studio software for Windows XP/Vista/7 and Mac OS X 10.5.8 and higher
- 100 exclusive ready-to-cut designs
  - Power cable, USB cable
  - 12” cutting mat
  - Cutting blade
- One month basic subscription to the online Silhouette Design Store
  - Crosscutter
  - Basic Instruction guide
DREAM IT UP. CUT IT OUT.

The creative possibilities with the new Silhouette CAMEO are endless.

Here are just a few:

- Design your own custom apparel
- Personalize a party
- Give your home décor a signature look
- Build 3D prototypes
- Cut fabric and save time doing it
- Decorate with vinyl decals
- Construct a school project
- Create custom invitations
- Make a stencil
- Create unique stamps
- And much more!

Some Ideas of things to make with vinyl:

- Decorate / Personalize Tupperware
- Decorate / Personalize Wine Glasses, Mugs, Cups, Water Bottles etc.
- Decorate small tile plaque
- Decorate Mirror, Windows, Picture Frames Etc.
- Decorate Buckets for Holidays.
- Decorate bulbs for Holidays
- Decorate / Personalize Household appliances
- Stay Organized by creating labels
- Create fun car decals and sayings
- Create Signs / Wood Signs
- Create wall decals with Oracal 631
- Heat Press Heat Transfer Vinyl (HTV) on clothing, garments, bags and much more!

There is a large selection of ideas on Pinterest, Facebook Groups, and more...
Changes between the Silhouette Studio V2 & V3

Home Screen Changed when you launch Studio

- **Design** – Opens a new work area
- **Store** – takes you directly to the Silhouette Online Store
- **Library** – takes you directly to your library
- **Open** – Allows you to open up a search window to open save silhouette files, saved designs etc.
Tool Bar Icons have changed

V2:
Home > Fill Color > Gradient > Pattern > Line Color > Line Style > Cut Style > Text > Move > Rotate > Scale > Align > Replicate > Modify > Offset > Trace > Tools > Cut > Reg. Marks > Grid Settings

V3:
Fill Color > Gradient > Pattern > Offset (New icon) > Line Color > Line Style > Text > Move > Rotate > Scale > Align > Replicate > Modify > Trace > Design Page > Reg. Marks (New icon) > Grid Setting > Cut > Send to Silhouette

- The Offset tool Icon image has changed and moved.
- The 'Page Settings' icon which was previously indicated by the 'home' icon is no longer on the tool bar. It's been replaced by a new page setting icon called “Design Page Settings” and it’s to the right of the Trace.
- Cut Style Settings Button was removed.
- The Cut settings button was replaced with a new icon that looks more like the blade with more options.
Silhouette Studio V3 Tools / Side Bar Options

Select Tool:
Edit Points:
Draw A Line:
Draw A Rectangle:
Draw A Round Rectangle:
Draw A Ellipse:
Draw A Polygon:
Draw A Curve Shape:
Draw Freehand:
Draw Smooth Freehand:
Draw an Arc:
Draw a Regular Polygon:

Text:
Eraser:
Knife:

Show Drawing Area:
Show Library:
Silhouette Online Store:
Show Library Full Screen:
Show Library & Drawing Area Split Screen:
Silhouette Studio V3 Tools / Top Bar Options

New Drawing: (Ctrl N)
Open: (Ctrl O)
Save: (Ctrl S)
Save To SD Card:
Send To Printer: (Ctrl P)
Send To Silhouette:
Copy: (Ctrl C)
Paste: (Ctrl V)
Cut: (Ctrl X)
Undo: (Ctrl Z)
Redo: (Ctrl Shift Z)
Pan Using Mouse:
Zoom In:
Zoom Out:
Drag over a shape to zoom:
Zoom in and out using mouse:
Fit to Window:
Silhouette Studio V3 Tools / Top Bar Options

Fill Color:
Fill Gradient:
Fill Pattern:
Offset:
Line Color:
Line Style:
Text:
Move:
Rotate:
Scale:
Align:
Replicate:
Modify:
Trace:
Design Page:
Registration Marks: (Ctrl F3)
Grid:
Cut: (Ctrl F2)
Send To Silhouette: (Ctrl L)
Silhouette Studio Designer Edition is the version of the Silhouette software made especially for designers. The Designer Edition includes more features to help designers import their own artwork as well as create new designs for use with Silhouette products.

- Multi-Cutting Support
- Ability to Open, Manipulate, and cut SVG files
- Rhinestone tools to convert designs into rhinestone templates and create your own rhinestone designs
- Sketch tools to convert designs into several styles of sketch-able art
- Creative knife tools to allow you to clip designs using different patterns
- Enhanced eraser set to modify designs with more precision
- Built-in ruler and guide lines for precise alignment and drawing
- Weed Line Options
- Advanced Nesting Features
- Great For Full-Scale – Large-Quantity projects
- Helps Save Time on Designing
- Cut out Extensive amounts of material
**Indoor Vinyl:**

Oracal 631:

Also referred as a removable vinyl and has a Matte finish. It’s most often used for vinyl wall decals and indoor signs that won’t be exposed to the elements or too much handling, also works great for short-term outdoor graphic applications.

It’s a 3 mil Calendered vinyl with a 3 year Outdoor Durability

- Outdoor Durability means guaranteed that long before it starts fading in the sun.
- The longer the vinyl sets (3+ years) the more permanent the adhesive comes
- Not recommended with wet applications when applying – it will interfere with the bonding process

**Outdoor Vinyl:**

Oracal 651:

Also referred to as a permanent vinyl and has a Glossy finish. It’s just not for outdoors though. It’s great for vehicle graphics, window decals, outdoor signs, mailboxes, dishes, jewelry etc. It is not recommended for wall decals it will tear the sheetrock and damage the wall.

**Heat Transfer Vinyl (Also known as HTV)**

HTV is what is applied to clothing, apparel, toilet paper, and hand bags etc. It is cut out in a mirror image (you are cutting on the back facing up) and is applied to your garment etc. with heat either using a hand iron or a heat press.
• Always Pre-heat your garment before applying HTV – this will not only smooth out your surface, but will remove any moisture in the fabric.

**Siser EasyWeed:**

Applies to 100% Cotton, 100% Polyester, Poly / Cotton Blends

Heat Press Settings: 305° for 10-15 sec, medium pressure, Peel Hot or Cold.

• Great for layering

**Siser EasyWeed Extra For Nylon:**

Applies to Nylon or other difficult applications such as leather

Heat Press Settings: 320° for 10 sec, light pressure, Peel Hot or Cold

**Specialty Materials GlitterFlex Ultra:**

Adheres to most fabrics, does not adhere to nylon, dazzle cloth, shiny polyester or moisture-wicking materials

Heat Press Settings: 330-335° for 17-20 sec, medium to firm pressure, peel warm & repress 2 sec.

**Transfer Tape:**

Transfer tape is used to move an adhesive vinyl design from the vinyl backing onto the surface where you want to apply the vinyl.

• Paper-back Medium Tack
• Paper-back High Tack
• Clear Medium Tack
Paper vs Clear

For most applications either one will work, it’s a lot about personal preference.

Paper tape is composed of a paper based face film coated with adhesive. It’s somewhat translucent, but not transparent. It’s softer and more flexible than clear tape. Ideal for using wet application method. Paper tape is recommended for applying vinyl on paper like cardstock when making cards etc. Works great for creating decals for re-sale where they will be setting awhile before transferring.

Clear tape is made out of a plastic face film so it is transparent. It works great for layering and more visibility when applying the vinyl. Not recommended for wet application, it also has a lower tack adhesive so not as effective in transferring certain kinds of vinyls.
• Import Jpeg or image you want to trace to create a cut line
• Under the Trace Window > Click Select Trace Area and draw a box around the image you want to trace.
• You get different looks depending on the Tracing Method you select
• **Trace Outer Edge** creates a solid outline cut line around the outer border of the image, so when you fill it creates a Silhouette look
  o This works great when you are doing a Print and Cut to create the cut lines around the image you will print
• **Trace** creates a double cut line around the edge of the entire design; so when you fill the image with a color like shown above you get an outline look of the design. Sometimes you might want this look.

**Tracing Settings:**

You can play with the trace settings until you get the outcome you are looking for. With some designs, de-selecting the check by High Pass Filter and adjusting the settings below help you to customize your cut line effect. You can also select the Low Pass Filter and adjust those settings or adjust the Threshold or Scale.

It will create cut lines that will outline the yellow design created in the trace box.
Welding works for taking more than one image or cut line and combining them into one image with no cut line between them.

Certain Fonts overlap creating small cuts you do not want, so you will need to weld the letters together to avoid the small cuts.

- The two designs you want to weld must be over-lapping, below is an example of a design and a word where there is over-lapping.

  ![Example Image](image_url)

- Select the entire image or font
- Under Modify Select Weld
- As long as the images were over-lapped they should now be one solid image and ready to cut
  - You can if needed – re-align the image to over-lap and Weld again.

  ![After Image](image_url)
- Compound Path – makes one solid image
- Grouping – Allows you to group – even different designs and words you later can ungroup and cut them out separately.

When you bring in a complicated design and create a trace, a lot of time Releasing Compound Path helps you with editing and deleting unwanted cut lines created with the trace.
Sometimes when you bring in a graphic and trace it, you want to make some changes and edit it. One way to do this is to “Edit Points”, this is located on your left hand tool bar. You can edit the points to completely change part of the image or to clean up a rough line

- Open up a Silhouette studio file or import your graphic and trace it to create cut lines.
- Select your cut lines and click on the Edit Points icon
- You will notice the image will now have points added to each curve or change in the line. Some images will more points than others and can be cleaned up or simplified.

You can see with my mustache that I traced there are some areas that have a lot more points than others, you can select and delete some of those points and re-shape the image.

- Click on a point and you will notice some features in the Point Editing panel on the right
  - Delete Point
  - Break Path
  - Corner
  - Smooth
  - Make Flat
  - Make Curve
  - Simplify

- You will also notice when you select a point you will see two blue points connected to the point, you can move these to scale and change the angle of the point arch / line.
- Each point can also be moved or rotated in any direction.
- You will also notice when you select a point that line between that point and a point next to it will change to a darker red – that is the direction the point is going. This comes important when deleting points and editing.
In the new Silhouette Studio V3 the cut settings got more advanced with more features. It actually combines a few of the old tools into one.

Here are some of the features:

- Select your Line Cut Style
- Select Type of Material
- Advanced Cutting Options
  - Layer options
  - Sketch Pen Option
    - The sketch pen is now listed under Material Type

- You can also cut by layers, you can change the line color of each design you want cut out of a different material and when you open your cut settings, click on the Line Color and you can select and de-select the layer by the line color you want and don’t want to cut.
  - While you have the line color selected you can choose a material under material type and customize what each material layer will be cut out of
- Once you select the material you will be cutting scroll down to find all your cut settings.
- Like in V2 – you can create your own material type for a specific material setting that works for you, by choosing your settings and click the + at the bottom right hand side of the Material Type and it will create a new material.
  - You can then Re-name the material how you choose to be able to go back to that setting.
Creating a Two-Toned layered design

- Can do this with a text or a design or shape or a combination of both
- Create your design or text
- Create an Offset
  - Select your design > Open the Offset window
  - Click Offset
  - Adjust the distance until you get the look you want
  - Click apply
    - When you click apply the offset will automatically weld together
- Fill the layers with the colors you want to cut them out in to see how it will look and then you are ready to cut each layer out separately.
Here are the steps for designing your knockout image in Silhouette Studio:

- Use the Text tool to type out your text
  - Pick a font that’s pretty bold – or use the offset to make the font thicker
  - Adjust Line & Character Spacing if needed to bring the letters closer together
  - Fill the text with a solid color
- Find and open the design you want to use as your knockout
  - If it’s not a .studio file, you will need to trace to create cut lines.
- Place the design over the text and align and scale where you want it.
- Select both the text and the design and “Duplicate” to make a duplicate
  - Align so they are one above the other on the screen
- Then open up the Modify Window
- Select Both the text and design of the top version > than click Crop
  - The design will disappear and you only see the fonts that were inside the design shape.
  - Group so it’s all back to one image
    - While it’s all selected > Right Click > Group
- Now go to the bottom version. Select both the text and the design again > click Subtract
  - The design will again disappear so this time you only see the outside of the fonts around the design
  - Group so it’s all back to one image
    - While it’s all selected > Right Click > Group
- Change the color of the top image and drag down to align over the bottom knocked out text to line up.
- You can scale the “knocked out image” a little smaller to create a little border between the two to make it easier to see and layer.
  - Holding shift while scaling with make sure you get an even scale
Weeding lines help cut the vinyl in the negative space down into smaller easier to manage sections. This makes it easier to weed and avoid wasting excess vinyl.

- Open a Silhouette Studio File you want to cut
- Use the Draw A Line Tool and draw a line
  - Hold down shift to create a horizontal line
- Select the line and copy & paste to create between the # you need to cover your design
- Select all the lines and rick click and select Make Compound path.
- Align your design over the lines where you want it
- Make sure your design is in the front
  - Select it, rick click > bring to front
- Select the weeding lines and the design at the together at the same time
- In the Modify window select Subtract All
  - This should remove all the cut lines inside your design
- Draw a line down each side to create cut lines on each side and then you are ready to cut.
**Subtract & Subtract All**

The Subtract tool allows you to cut out or subtract sections of designs so the perfectly align with other designs.

The secret to the Subtract tool is layers. Depending on which layer of your design is in the front and which is in the back will determine what piece is subtracted from the other.

- Open or create the designs or words you want to subtract from each other.
- Make sure the image you want to be subtracted from are in the back
  - Select them > Right Click > Send To Back
  - This is the image I’m going to use – see how I have the “&” Symbol over lapping the J and H.

```
J&H
```

- Open the Modify Window
- Select all your images and click Subtract All
  - You must select everything all at once in order for the Subtract and Subtract all to work

```
J&H
```

- As you see above I moved out the J & H and now have a subtracted area where the “&” symbol is.
- Subtract All allows you to subtract the overlapping area of the designs without losing the images.
- Subtract allows you to subtract the top shape / design from the below shape and will delete the original shape.
See below we lost the “&” symbol but have the cut out on the J & H of it.

CREATING RHINESTONE DESIGNS

In order to create a custom Rhinestone design you will need the Silhouette Studio Designer Addition Upgrade. With this you can turn any design or any font into a Rhinestone design very easily.

- Open up the design you want to convert to rhinestones or type a word in Silhouette Studio
  - If it’s a clipart you will need to trace to create the image into cut lines
- Select your cut lines / design > and click on the Rhinestones Window in the upper tool bar
- The Rhinestone window will open and you will notice there is a Rhinestone effect column with different options to choose from, a Rhinestone size column with the stone size to choose from, a spacing column, a Drawing column and a rhinestone count at the bottom
- First choose your rhinestone size
- Click on the different Rhinestone effects and choose the look you prefer.
- Edge adds stones along all the cut lines to create an outline of stones.
- Linear Fill adds stones inside the entire design while keeping them evenly spaced in a linear fashion.
- Radial Fill adds stones inside the entire design in a scattered fashion.

- I like to go to the Fill Color on the top tool bar, and fill the rhinestone circles with the color of stone I will be cutting to get a better idea of what it’s going to look like.
- Back in the Rhinestone window you can adjust the Spacing bar left or right to get adjust the look and quantity of the stones you want.
- It’s best to zoom in to make sure you have enough spacing between the stones, and to make sure nothing is over-lapping.
- You can select the Single Click under Draw Rhinestones and add some stones to areas you want or need more stones.
  - Make sure to group those with the larger design once you have them placed.
- You can also click the select arrow and click on the design and you will notice that it will show you some editing points, you can select those and move them to adjust the stones.
  - If you don’t see it right away > double click on the design
- You will notice the Point Editing window will appear and you can edit the points as needed.

You can create a new design or font and align next to it in a different stone color to get it the size you would need so that they align. You would just need to have those on different layers so you can cut them out on different templates.

Once you are ready to cut the design, you will cut it out on a rhinestone template and follow the steps on the next page.
Rhinestone Decorating made simple with the CE5000 & FC8000

1. Choose a pre-mode rhinestone design — or create your own with i-Design™ CE or PRO software. Do NOT resize it.

2. Peel the backing from the template material leaving the circle cutouts behind. It works best to peel the material off in one quick motion.

3. Affix the template material to a rhinestone backing board.

4. Set blade depth
   - Set the force to 24
   - Set speed to 30
   - Set quality to 1
   - Set Tangential Emulsion to 1
   - Set the Start and End points to 0.028".

5. Gently brush rhinestones into template holes using a brush (one is provided in the optional Starter Kit).

6. Lift the rhinestones (now attached to transfer tape) from the template and position the design on desired surface.

7. Set the heat press to 350 degrees F, for 10 seconds, press on medium.

8. Let the rhinestones cool, then peel the transfer tape.

9. Wash and dry clothes inside out. Use caution when operating a heat press.

The new rhinestone design is now ready for sale!

©2010 Graphtec America, Inc. All rights reserved.

GRAPHTEC

SIGNS+ BANNERS 1-800-635-6897  www.signsplusbanners.com
Before Application:
- Preheat Iron to cotton setting
- Place fabric for heat application on a firm, smooth surface (Ironing board not recommended)
- Preheat garment for 2-3 seconds

1. Cut image in reverse (mirror)
2. Weed (Pick) excess material
3. Place transfer on the garment as desired
4. Use a cover sheet, such as parchment paper or a heat transfer cover sheet

5. MEDIUM-FIRM Pressure (Light Pressure for EasyWeed® Extra) 10 seconds Make sure to cover entire image **DO NOT SLIDE IRON**
6. Remove the clear polyester carrier
7. Use a cover sheet and reheat for another 5 seconds
8. For best results, wait at least 24 hours before first wash

**RECOMMENDED ACCESSORIES:**
- Siser® Weeder
- Multipurpose paper
- Heat transfer cover sheet
- Parchment paper

**WASHING INSTRUCTIONS:**
- Machine wash warm or hot with mild detergent
- **Wait 24 hours before first wash**

* Due to variances in the manufacturing process of fabrics, Siser highly recommends testing prior to production.*
How to Nest and Re-Use Scrap Vinyl Pieces

Designer Addition Upgrade & V3 Required

- First Find your scrap pieces
- Place them on your mat
- In Silhouette Studio – Draw a rectangle the size of the scrap piece and align where it sets on the Mat
- Show the Cutting Mat in the Silhouette Studio so you can see the grid
- Type in your word – and ungroup the letters; they must be ungrouped to be able to be nested.
- Select Box > Go To Nesting Tool
- Click on “Set Selected Shape as Boundary”
- Then Select all the letters and click Nest.
- You can do the same thing with shapes etc. vs. fonts.

Tip: If you have odd shape scraps, create different boxes / circles to replicate the design and you can weld the shapes together
OPENING SVG FILES INTO SILHOUETTE STUDIO

Basic Studio

Download and Install Inkscape

https://inkscape.org/en/download/?lang=en

Launch Inkscape

Open the SVG file you want to convert

Save As > Desktop Cutting Plotter > Use ROBO-Master type of Spline Output”

Click OK

Launch Silhouette Studio

Open > All Files > Select the file you just saved

Now you can cut in Silhouette and save as a Silhouette File

Designer Addition

In Silhouette Studio:

Open File > Import > Import to Library

Change Files of Type to: SVG and choose your saved SVG file  Click OK

The file will be in your Silhouette Studio Library
TIPS TO APPLYING VINYL STRAIGHT

After you cut and weed your vinyl decal, apply your transfer tape and use a scissors to trim the design down, cutting the top as close to your design as you can (do not peel vinyl off backing paper yet).

You will need a pencil, masking tape and a ruler.

Use the ruler and pencil to mark straight points on the surface you are applying the vinyl letter to, marking where you want to align the top of the vinyl design.

Position your design and apply a strip of masking tape along the top so half of the tape is on the vinyl design and the other half is on the surface to hold the decal into place.

Double check to make sure it’s aligned where you want it and straight.

Flip the decal up so the backing paper is exposed, then carefully peel off the backing paper.

Slowly from the top down roll the decal onto your surface; you can use a squeegee or a yard stick to help smooth the decal on the surface.

Using a squeegee, go over your entire decal again. Slowly remove the transfer tape.
After you cut and weed your vinyl design, apply your transfer tape (preferably paper-back transfer tape)

You want to apply from the center and work outward.

You can take a scissors and cut into the sides of your vinyl design through the tape to help form around the design.

Some like to take a hair dryer to heat up the vinyl on the tape for a few seconds to make it easier for applying.

Slowly apply your design on your curved surface by starting in the center and using your finger to work outwards as you apply.

Carefully pull off the paper transfer tape. Use a hair dryer and a squeegee or your finger to work out any bubbles and to make sure it’s firmly pressed onto the surface.

• If you are still having problems, check to make sure your design is not too big for the curve of your surface.

If you want to cut your vinyl at an arch to align on the glass, you can do that by determining the arch of your surface.

To do this, take a piece of paper and marker, place the glass (example wine glass) on the paper and turn while holding marker on top to draw an arch.

Use your PixScan to scan the image into Silhouette and create the same arch and lock your design / words to that arch.
Create A Sketch Using A Single Sketch Pen:

Open or create a sketch design.

Position a piece of paper or cardstock onto a cutting mat and load it into the Silhouette Cameo.

Select a Silhouette Sketch Pen, remove cap and place the pen into the blade holder.

In the Silhouette cut settings material list, select “Silhouette Sketch Pens” and change the blade type to “Sketch Pen” then press “Cut”.

Create A Sketch Using Multiple Sketch Pens:

Follow first two steps from above.

Select all the lines of your design and set them to “No Cut” in the cut style menu.

Select all the lines you want to sketch with a particular pen color and set them to “Cut” in the cut style menu.

In the Silhouette cut settings materials list, select “Silhouette Sketch Pen” and change the blade type to “Sketch Pen” then press “Cut”.

*Do Not unload the mat or reposition the on-screen image until the entire sketch is complete.

Repeat Steps 3-6 for each individual pen color until your sketch is done.
Create a cutout of a sketch design:

Open or create a sketch design in Silhouette Studio. Decide what color you want each line to be and which line is to be the cut line.

Position a piece of paper or cardstock onto a cutting mat and load into the Silhouette Cameo.

Select all the lines and set them to “No Cut” in the cut style menu.
Select all the lines you want to sketch with a particular pen color and set them to “Cut” in the cut style menu.

Load the desired Silhouette sketch pen into the blade holder of your Silhouette Cameo.

In the Silhouette cut settings material list select “Silhouette Sketch Pen” and change the blade type to “Sketch Pen” then press “Cut”.

Repeat steps 3-6 for each individual color until your sketch is done.

- Do Not unload the mat or reposition the on-screen image until the entire sketch is complete.

After the sketching is done select all the lines and set them to “No Cut” in the cut style menu.

Select the lines you want to designate as cut lines and set them to “Cut” in the cut style menu.

In the Silhouette cut settings materials list, select the material type that you want to cut and adjust the blade indicated.

Load the blade into the blade holder then click “cut” in the Silhouette cut settings menu.

Unload media and you are done!
Creating Thin Lines / Fonts with Sketch Pens

A lot of people want to know how to use the sketch pens to create a single line font and not a “bubble” looking font. The way the Silhouette Cameo works is there is not a way to do that, the trick is to finding the perfect font(s) that create very thin looking lines.

What most don’t realize is that the Silhouette Studio Software reads the fonts that are already downloaded onto your computer / laptop – so not all computers are created equal. You will notice this if you created your design on one computer and opened it on another computer.

Online Silhouette Store sells some thinner fonts, but the trick is to find the thinnest font possible and choose the best one.

You can also create multiple inner offsets of the font making the lines very close together so when you sketch them out with the sketch pen it will sketch over all the lines and create a filled in looking font.

To purchase a Silhouette Cameo, for more information, or for answers to further questions, please call Crafters Corner Supplies at 1-800-635-6897 or visit www.crafterscornersupplies.com